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Introduction

How to Contact Fluke

DPCTrack2 Calibration Management Software (the
Software) helps you manage instrument calibration and
maintenance. Make, update, and manage records for a
variety of item types that include:

To contact Fluke, call one of the following telephone
numbers:

•

Test Instruments

•

•

Loops

•

Equipment

•

Calibrations

The Software lets you download your calibration
procedures into a Documenting Process Calibrator (DPC)
for field use. It also lets you upload field test results to a
calibration or instrument database.

•

•
•
•
•
•

Technical Support USA: 1-800-44-FLUKE
(1-800-443-5853)
Calibration/Repair USA: 1-888-99-FLUKE
(1-888-993-5853)
Canada: 1-800-36-FLUKE (1-800-363-5853)
Europe: +31 402-675-200
Japan: +81-3-6714-3114
Singapore: +65-6799-5566
Anywhere in the world: +1-425-446-5500

Or, visit Fluke's website at www.fluke.com.
To register your product, visit http://register.fluke.com.
To view, print, or download the latest manual supplement,
visit http://us.fluke.com/usen/support/manuals.
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The latest software trial version of DPCTrack2 can be
downloaded at www.fluke.com/DPCTrack. For more
information see “Communication with a PC”.
753/754 Accessories can be found at
www.fluke.com/process_acc .

Installation Requirements
•

Pentium class 667 MHz or higher processor

•

Minimum of 256 MB of RAM (512 MB or more
recommended)

•

Windows XP (or newer) operating system

•

At least 500 MB of free hard disk space

•

CD-ROM drive

User Groups, User IDs and Passwords
The Software includes three predefined User Access
Groups with Users assigned to them and one Technician
Group with one Technician assigned. All users must be
assigned to one of the predefined User Access Groups.
Note
The User IDs and Passwords listed are not
case-sensitive.
The predefined User Groups are:
•

The Admin (Administrator) has full access to all
areas of the Software. The Admin can do
administrative responsibilities, such as change
system options, back up data, add technicians and
other users, add user-defined variables, erase data,
and more. Typically, one person is the Admin of the
Software. The User ID and default password for the
Admin User group is ADMIN/ADMIN.

For calibrator communication:
•

ADMIN

USB 1.1 or higher
•

USER
The access rights of the User are different from those
of the Admin. A User cannot do administrative tasks.
The User can approve changes, add or change
records, download and upload tasks to the DPC and
see logged data. The User ID and default password
for the User Group is USER/USER.
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•

READONLY
The access rights of the READONLY user are more
strict than those of the User. Data can only be read.
READONLY users can download and upload tasks to
the DPC to give Test Results records. The User ID
and default password for READONLY User Group is
READONLY/READONLY.

•

Note
The Software can also be downloaded and
installed from http://www.fluke.com/dpctrack2.
Click on the Download Software link.

TECH
The Technician Group is TECH.
There are no access rights for the Technician. The
Technician group is for display only. For example,
Who Calibrated or is the Responsible Technician for
the record shown? There is no User ID or password
for the Technician.

How to Install the Software
Note
The Software is fully-functional Trial Software.
The trial period expires after 60 days. See the
“After the Trial Period” section.
To install the Software from the CD-ROM:
1.

gts001.jpg

Figure 1. Software CD-ROM Screen

Put the CD-ROM into your computer CD-ROM
drive. If the CD-ROM presentation does not start,
go to Windows Explorer, find the CD-ROM drive
and click on "launch.exe". The presentation
launches. See Figure 1.
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2.

Click on the Install DPCTrack2 Software button.

Software License

3.

For both CD-ROM and Internet installation, follow the
onscreen prompts to install the Software.

The first time you launch the Software you see the
Licensing Screen. See Figure 2.

4.

The End-User License Agreement is shown. The
software will not install if you do not accept the EndUser Agreement.
The default location for the Software installation is
C:\Program Files\Fluke\DPCTrack2\ or
C:\Program Files (x86)\Fluke\DPCTrack2\ on a 64bit PC. You can choose a different location when you
install the Software if necessary. The data directory
defaults to: C:\DPCTrack2\Data. You can choose a
different location during installation if necessary.

5.

4

Note
The data directory can be on a shared network
storage device but only this version of the
installed Software can access it.
For Setup Type, select Standard.

gts002.jpg

Figure 2. Licensing Screen
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Three install types are available:
1.

Start Trial
Start Trial lets you use the Software for the first 60
days. See the “After the Trial Period” section for
more information.

2.

Register
You can register at these times:
•

During the first launch when you select Trial
(instead of Activate).

•

Each time a Trial expiration warning is shown (if
you have not registered).

•

Through a menu option Help> Register Trial (if
you have not registered).

The registration procedure is the same, regardless of
which registration choice is selected. You must
record:
•

Company

•

First Name

•

Last Name

•

E-mail Address

•

Phone Number.

3.

Activate
Activate prompts for a POP Number and other
information for verification. This data is sent for
confirmation and used to make an Activation Code
which is sent to you for entry into the Software.

After the Trial Period
If you do not register the Software after 60 days, you can
continue to see data that was recorded in the Software
database. The Software lets new results in the DPC be
uploaded to the PC but only as a txt file. The new results
will not go into a database that was made during the
Software trial. If data is recorded in the trial period and it
is necessary to save that data, it is recommended that
you purchase the Software before the trial period ends.

How to Remove the Software
The Software can be safely removed from your PC. Go to
your system Control Panel, and click Add or Remove
Programs (for Windows XP users), or the Programs and
Features (for Windows 7 users). Click Fluke DPCTrack2
from the list, and select Uninstall Program.
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Software Updates

Language Selection

After the Software is installed and launched, go to the
Help menu and check for updates. The Software tells you
what to do if it finds that updates are necessary.

The Software features a localized user interface. The
subsequent languages are available:
•

English

Run the Software for the First Time

•

French

•

German

•

Italian

•

Spanish

•

Portuguese

You must record a login and password each time you
operate the Software. The first time you use the Software,
the Login and Password are each "ADMIN" (without the
quotation marks and not case sensitive). On older
versions of the Software, you must change the password
when you first login. In later versions, this is not
necessary.
Note
You must remember your Login and Password
or the Software will lock you out. If you are
locked out, you must contact Fluke Technical
Support. See “How to Contact Fluke”. You have
three chances to login before the Software locks
you out. You can change the login lockout
parameters in the System Options menu. See
the “System Options” section.
When you have logged into the Software, you can access
all of its functions and also change some of the system
options. See System Options.
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The default language can be selected when the Admin
installs the Software. Users can also change the user
interface language associated with their account at any
time.
To change the localized user interface after installation:
1.

Go to the File menu and select Change Preferred
Locale.

2.

Select the necessary language. See Figure 3.

Calibration Management Software
Run the Software for the First Time
USB Driver
When you install the Software, a USB driver is also
installed so that the DPC can communicate with the
Software via USB cable. The driver lets you use the DPC
with other software packages.
If you need to re-install the USB driver, download it from
http://www.fluke.com. Select the Software Downloads link
under the Support tab. On the Software Downloads page,
select the Process Calibration link and then click on
“Download 753/754 Windows Driver” under the
TM
“Download DPC/TRACK2 Software” section. This is an
executable file that will launch and install the driver.

Client Server Solution
gts008.jpg

Figure 3. Language Selection
The Software interface changes to the user-selected
language. The language choice is stored as part of the
user preferences. Each time the user logs in, the
Software interface uses the saved preference. If the
Admin has set the interface environment to a particular
language, a user can still change to another language of
their choice.

If multiple-client Software is necessary to access one
shared database, there is a Client-Server version of a
comparable product that lets you do this. ProCalV5
provides network-sharing capability and other advanced
tools. DPCTrack2 is for one PC only. It lets you have
multiple user accounts on that single installation.
ProCalV5 lets you share Documenting Process Calibrator
data with others. For more information or to purchase
ProCalV5, go to http://www.DPCTrack2.com.

A user with Admin privileges can use the System
Options dialog to change the interface language, which
includes the default language for new users. If this setting
is changed, it does not affect the language settings
associated with the current user.
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How to Check Communication
Connect the DPC to the computer with a USB cable.
To verify communication between the DPC and the
Software:
1.

Click

2.

In the Ports section of the screen, you will see the
DPC. If you do not see the DPC listed, or you have
reason to think the Port information needs to be

.

updated, click

to refresh the view.

Note
If you still do not see the DPC listed, go to the
Windows Device Manager and see if the Fluke
753/754 (COM#) entry is shown under Ports
(COM & LPT). If the DPC is not shown,
reconnect the DPC to the PC and do step 2. If
you have a 74X connected, then “USB Serial
Port” is shown.

Brief Tutorial
The Home Screen
From the Home screen, you can navigate through the
Software to set up and do necessary tasks. Some of the
functionality of the Software is only available through the
Home screen. See Figure 4.

Navigation Buttons
The navigation buttons on the left of the Home Screen
access different record sections of the Software. Right
click on the buttons and choose “Show Captions” and the
button names are shown. The navigation buttons are
shown in Table 1.

gts007.jpg

Figure 4. Home Screen
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Table 1. Navigation Buttons
Button

Description
Company- A Company record must be made before you can record device information. The Company record
contains name, address, contact information, options, and a selection of default report choices.
Instruments- Use this screen to add, show, change, and remove instrument records. General information,
Calibration points, and other data about each instrument are put into this record.
Loops- Use this screen to record data about the loop components or equipment used in your test environment.
Information about the location, personnel, calibration points, and more can be recorded.
Equipment- Use this screen to record data about the equipment used in your test environment. General
information about the equipment, instruments and loops, and more information can be recorded.
Test Instruments- Use this screen to record data about the test instruments used in your environment.
General information about the instruments, calibration points, and more information can be recorded.
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Table 1. Navigation Buttons (cont.)
Button

Description
Calibrations- Use this screen to add, display, change, and erase the results of an instrument, loop, test
instrument or system calibration. After you have recorded master instrument, loop and test instrument records,
you can make calibration records from those you already recorded in the database.
Documents- Calibration document records can be linked to this screen. Use this screen to add, show, change,
or delete document records.
Upload/Download- Upload- Data (calibration results for example) is sent to the Software where it is stored in
the Software database. Download- Data is taken from the Software (tasks and calibration procedures for
example) and stored temporarily in the DPC for field use.
Logged Data- Use this screen to import recorded logged data from the DPC to the Software. Logged data can
only be uploaded through this screen.
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Notice that as you move through each of the different
sections of the software, the menu bar above the main
window changes for each current record type.

Notes
•

These examples can be changed or copied and
used as the basis for new records. When
changed, they can be saved to the DPCTrack2
database and, as needed, downloaded to the
DPC as a task.

•

You can erase the sample records so they do
not contaminate your actual data. The sample
records could potentially be included in your
reports and data analysis. However, remember
that sample records can be copied, changed,
and saved as new records. Use the copy
command to do this. This is the most simple way
to create a new record.

How to Access Sample Records
The Software comes with sample records that you can
use to learn more about how the Software works.
To see the full list of sample records, click
. This will show you a new list of
existing records in a vertical bar parallel to the navigation
bar.
A list of folders is shown on the left:
•

Instrument

•

Test Instrument

•

Cals Due in 45 Days

Note
Records of equipment and loops will also show if
they have been added.
Double-click Instrument and sample instrument records
are shown. For the tutorial, you will make a copy of the
“EXAMRTD-TRANS” (Example RTD Transmitter) record.

11

DPCTrack2
Users Guide
Double-click on EXAMRTD-TRANS to open the record.
The Instrument Screen is shown. See Figure 5.

How to Copy a Record
To make a copy of this instrument record:
1.

Click on File>Copy Record on the top menu bar.
Note that the Tag ID field in the instrument record
clears itself.

2.

Record a new Tag ID for the instrument record.

3.

on the Instrument Record Screen to save
Click
the new instrument record.
The new record does not automatically show in the
instrument list on the left. To see the new record in
the list:

gts004.jpg

Figure 5. Instrument Screen

12

4.

Right click on
and click
Refresh Tree to refresh the instrument list.

5.

Double click on the Instrument folder. The new
instrument record is shown in the list.
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How to Change an Instrument Record

How to Make an Instrument Record

For this section, you will change the calibration data.

This procedure is available to ADMIN and USERs. To
make an instrument record:

1.

2.

Click on the Calibration Points tab on the changed
instrument record. Use this screen to add or change
calibration values.
You can change the parameters input type, output
type, and low and high ranges to match your device
type.

3.

Click the DPC Settings button for mode options.

4.

Click the Calculate button and the Software
automatically calculates the test points for you.

5.

After you change the data, save and close the
record.

and open the Instrument Record Screen.

1.

Click

2.

Click

3.

Record the instrument information into the correct
fields of the form.

4.

Approve the record in the bottom right corner. Check
the “Approved By” box.

5.

Click

to make a new instrument record.

to keep the new record.

How to Make, Revise and Retire an Instrument
Record
Instrument records can be made or revised in the
Software. The subsequent sections give short
descriptions of instrument record creation, revision, and
retirement.
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How to Revise an Instrument Record

How to Retire an Instrument Record

This procedure is open to ADMIN and USERs. To revise
an instrument record:

This procedure is available to ADMIN and USERs. To
retire an instrument:

and open the Instrument Record Screen.

1.

Click

2.

Click on

3.

Double click on the instrument record that you will
change. The Instrument Record Screen for the
newly-selected record opens.

4.

Change the record as necessary.

5.

Click

14

to open a list of Instruments.

to save the record.

and open the Instrument Record Screen.

1.

Click

2.

Click on

3.

Double click on the instrument record that you will
retire. The instrument record opens.

4.

Change the status to “Inactive” or “Out of Service”.

5.

Click

to open a list of Instruments.

to save the record.

Calibration Management Software
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Make, Revise, and Retire a Test Instrument
Record
The Software keeps data for Test Instruments and
Instruments separately. To make, revise, or change a
Test Instrument Record, see the subsequent sections.

How to Revise a Test Instrument Record
This procedure is open to ADMIN and USERs. To revise
an instrument record:

This procedure is available to ADMIN and USERs. To
make and instrument record:
1.

Click
Screen.

and open the Test Instrument Record

2.

Click

3.

Record the instrument information into the correct
fields of the form.

4.

Approve the record in the bottom right corner. Put a
check mark in the “Approved By” box.

5.

Click
created.

to make a new instrument record.

and open the Test Instrument Record

1.

Click
screen.

2.

Click on

3.

Double click on the test instrument record that you
will change. The record opens.

4.

Change the record as necessary.

5.

Click

How to Make a Test Instrument Record

to open a list of Instruments.

to save the record.

to save the record. The record has been
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How to Retire a Test Instrument Record

How to Download Data to the DPC

This procedure is available to ADMIN and USERs. To
retire an instrument:

To download data from the Software to the DPC:

and open the Test Instrument Record

1.

Click
Screen.

2.

Click on

3.

Double click on the record that you will retire. The
instrument record opens.

4.

Change the status to “Inactive” or “Out of Service”.

5.

Click

to open a list of Instruments.

.

1.

Click

2.

Select the Instrument from the list, in this case
“Instrument EXAMRTD-TRANS”.

3.

Click the Download tab.

4.

Make sure that your DPC is selected in the Ports
window. If you have problems, see the How to Check
for Communication section.

5.

. The Software downloads
Click on
information to the DPC.

to save the record.

Download and Upload Data

To find this data on the DPC:

The subsequent sections give you more information
about the Data Upload and Data Download functions.

1.

Push the More Choices softkey.

2.

Push the Tasks softkey.

3.

The downloaded task shows on the display.

4.

Push the Go To Task softkey.

5.

Add the task number.

6.

Push the Done softkey.

7.

Push .

•

Download- Data is taken from the Software and
recorded into the DPC.

•

Upload- Data is added to the Software.
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How to Upload Data to the Software
To upload the data from the DPC to the Software:
.

How to Print Reports
The Software includes many reports that you can print.
From the Home Screen, select Reports from the top
menu. A list of report categories is shown:

1.

Click

2.

Click the Upload tab.

•

Alert

3.

Make sure your DPC shows under Ports.

•

Calibration

•

Company

4.

Click

•

Document

•

Equipment

•

Instrument

•

Inventory

•

Logged Data

•

Loop

•

Test Instrument

•

User

.

The data uploads from the DPC to the Software.
If the Tag used for a result is not found in the Instrument
or Loop screens, you will be prompted to save the result
to a file. To prevent this, make an Instrument or Loop
record beforehand. The record ID must be the same as
the Tag on the DPC associated with the upload data.
After you authorize a calibration during upload, you can
see and update the calibration record in the calibration
screen if there are additional values to view, edit, or
remove from the record.
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In these report categories there are multiple reports that
show a wealth of data each category.

How to Print Records
You can print records from these menu locations:

To print a report:
1.

Select the report from the list (Reports>[Report
Name]).

Instruments

2.

Click on the Preview button at the bottom of the
report window to see the report first, or click the Print
button to print the report.

Test Instruments

Calibrations

Document Records

Logged Data
To print a record from these locations, click
top of each window.

on the

Note
Each Instrument has a unique tag assignment. If
you change a data tag and then upload it to the
Software, the tag is different than it was
originally and the Software will ignore the tag.
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System Options
You can change many of the system options of the
Software.
Note
Only members of the ADMIN group have access
to the System Options.
To change system options:
From the Home Screen of the Software, select
File>System Options. The System Settings screen is
shown. See Figure 6.

gts006.jpg

Figure 6. System Settings
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From the System Settings screen, you can change these
options:

You can change these and other settings from the Locale
Settings screen:

•

Last Date The System Database Was Backed Up

•

Date Format

•

Number of Days Between Backup Warnings

•

Number Format

•

Number of Days Before User’s Password Expires

•

# of Logins Before Disabling (0 = Never Disable)

•

Minimum Password Length

•

Number of Passwords To Remember

•

Minimum Password Age To Allow Change (Days)

•

Number Of Minutes Before Time-out

•

Default Skin

•

Explorer Display Format
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at
When you have changed system settings, click on
the top of the System Options screen to save the setting.
The settings are self-explanatory. For more information,
see the DPCTRACK2 Users Manual.

